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Marq User Guide

> Browse Purdue Global’s collection
of customizable design templates.

> Quickly create consistent and
cohesive designs.

> Share and collaborate on
documents with colleagues.

> Implement and elevate the Purdue
Global brand design and essence
throughout your communications
and marketing assets.
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Overview

Marq homepage

> Your homepage is your
starting point. You can
navigate to your Projects,
Images and Brand Templates
in the left column.

My Projects houses your
in-progress and completed
Marq documents. Jump back
to the homepage by clicking
on the Purdue logo in the
upper left corner.

PURDUE
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LEFT
NAVIGATION

------------ { Download your file ] Ceveeeeaen [ Marq features }
2P LIRDVE
{a} Home
O myerojects Virtual Backgrounds
&  Myimages Enhance your Teams or Zoom background with a beautiful
campus image. Customize it with your unit's co-brand too!
@ Templates Select Template
&  erand Assets l

Data Automation
Analytics

Print Portal

@D 00

Hello Emily,

Lets get started where we left off.

Recent Projects

SAVE
THE DATE

“31-LINE QUOTE
UNDERLINE A WORD
TO EMPHASIZE"

00.00.00

EVENT TITLE
Lacatm

PG IG Save the Date PG IG Photo w/ Quote

15x1875iIn

View All Projects

HEADLINE

LECTURE TITLE
GOES MERE

yo

PG 2-Sided Story Flyer PG Social Lecture Series
85xiin

1667 x 875 in
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......... Overview .............[Createadocument]............{Downlgadyourfile].............[ Marqfeatures }

Brand assets

> Purdue Global brand fonts and - i
_ Text Shape Layout
colors are preloaded in Marg. They .
don't need to be installed on your
device in order to use them in Margq.

> CMYK and RGB color palettes are Brand Colors

displayed in the Shape > Fill menu L |

for shapes, and in the Text > Fonts
menu for text,

Fill

Use on Use on Social/
Print Projects Digital Projects

PURDUE
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Overview

Select a
template

> In the Left Content Pane,

click on Templates, the icon with
the star, to view and browse the
brand templates.

> You can narrow your search

(h

PURDUE

Q' GLOBAL

by using the Filters column.

SEARCH FILTERS

R
| - -

q Templates
Home @
My Projects (]
M)‘ |mﬂgBS E Brand Templates Shiaged with Me Personal Templates
J i
Templotes ® All User Groups
Brand Assets @ | &, eurduesiobal
Data Automation E
17 Starred
Analytics il
Campaigns  [niw ]| = Q
PG News - 2 Image Hea..
Print Portal * Campaign BEHD % 417
[/] Purdue Global 14
* Purdue Branding
FLYER TITLE HERE
Ce-Brand Loge 3 ONE OR TWO LINES
Pt oo 5
* Media =
Digital (RGE) [ -
print {CMYK) 5 =
o
Social 3
+ PrintFormat PG 2-Sided Multi-Phato
Flyer 5
* Social Media
Instagram (1G) 2
Social 2« (F8, TW, L) 1 . .
~ Digital Format ..
@ Digital Newsletter G.. & P
g | v Bleeds == oo
Full Blead 3

Q

PG News - 3 Image Hea.
BEI% 41T In

SAVE
THE DATE

00.00.00

PG 13 Save the Date
152 1675

PG Social Lecture Series
16672875 In

FLYER TITLE HERE
12 LINES

PG 2-Sided Story Flyer
B5x0lin

w o

PG Event Flyer I-Speaker
B5 Kl
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......... [ Overview ] ............ Create adocument

Preview or
use a template oy

> Preview a template by hovering and
clicking on its icon in the template “3-LINE QUOTE.
gallery. UNDERLINE A WORD

> Click the Use Template button to TO EMPHASIZE.’
open a template as a new document. |

First Last / Title, major or degree

Purdue Global

Template Brand
PG IG Photo w/ Quote CAEee®  USE TEMPLATE

ses 9y  UseTemplate

(8" PURDUE
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......... [ Overview } Create a document ............{Downloadyourfile].............[ Marqfeatures }

Create a document
from a template

> Rename the document in the Save as
field.

> Click on Create Document.

Create Document From Template X

Save As ‘ |Co—Brcmd Presentation ’

> Your new document will open and
autosave to your My Projects folder.

Location | [l My Projects v |

CREATE DOCUMENT

PURDUE
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......... [ Overview ] Create a document ............{Downlgadyourfile).............[ Marqfeatures }

Document workspace
> When your Marg document is open,

. - ¢ aaex | PG Sociallecture Series A print  (T) Shara
you will see the main menu bar at the top, ot ] e v sregn v o 59
. . . : 83
which contains drop-down menus for File, >
View, Arrange, Insert and Help. o " & roneation
> On the left side is the content pane, which K3 e e “m :
has tools to create your design. You can : . owes S
add pages, text, images, shapes and charts. " LECTURE TITLE Click
. : . . s A R RS placeholder —
> For digital and social projects, click the GOES HERE boxto T
three dots in the lower left corner to add Ao B e L
. (" Eventdate insert image + Project Approvai
buttons and videos. = ———
Location
H Other details
-
CONTENT PANE | guuuiic®
"::"° ] comments =} chat (%) support [l Feature Find

(8" PURDUE
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......... [ Overview ] Create a document ............{Downlgadyourfile].............[ Marqfeatures }

Simplified editor tools

These editor tools make creating and TEXT EDITOR
editing your document even easier:

> Click on a text box, image or graphic in

) ) ) . Acumin Pro.. | — 16 PT + & B I U A '_} E _ 0 PX -_ -I-' &’
your project, and quick actions like : ' ‘ = E— E—
font, colors, border weight, etc., will
pop up by the object you selected.
> Text boxes: Easily change the
font type, size or weight.
> Images: Replace with a different D Replacelmage . I, (2| e
image, crop it, add a filter, turn it into

an image smart field or add a hyperlink.

> For more options, click the three dots
on the right end of each editor tool, and
an Advanced Tools menu will appear.

SHAPE EDITOR

WO o+ o[

(8 PURDUE
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......... [ Overview } Create a document ............{Downlgadyourfile].............[ Marqfeatures }

Add text

IMPORT TEXT FROM DRIVE

Purdue Global's brand templates contain
. - Btk PG Event Flyer 1-Speaker = & Print T
placeholder text, which you can customize =2 ) rio view range L] o a g 0 S
. f T Acumin Pro *  Medium Text Box . o L —opt = = = = 1Z[120nesd = - I= - & 08
with your own content. Here's how: « ———
. . 0 Vider.\- ] +Fonts
> Double-click on a text box to type in - oot TITLE IS PLACED HERE Tl
your content. 8 Commnt ‘ ONE OR TWO LINES are -
Guides ==== T%$i
> Or upload a Word document to a B i ® pe—
- s Mail Merge Field Click One or more professional title(s) ] » Bullets & lists := - [= -~
Google drive, and under the Insert tab o o smenr - plodr T CULE
H H H Dataset Image » : to Ll i =] =
in the top navigation, select Import . o insert inage oomne
- o . e o s | abstmaens 5
Text from Drive. * T —— ——
E Creator Name
e Projau:mun.ne B LOCATION * Warp None v
E ...................... i::a:::ﬁ':’:::v tea * Link
Page Number Hyphwnation
E Page Count

PURDUE
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......... [ Overview ] Create a document ............{Downloadygurfile].............[ Marqfeatures }

Paste text into a document

If you paste text on a color background, white Tl Shope | layout

boxes may appear behind the words. To remove MAIN S

the boxes, select the text with the Text tool, and go T > (E

to Fonts in the Text tab: HEAD”NE Regular - 1

> Click on the “T" in the Fonts menu. Another B K
menu will pop up. | | = ==== ~ 4

, _ _ _ Lorem ipsum dolor sit amet, s AAYTT Tr[X]

> Then click on the "T" with the line through it. consectetuer adipiscing|elit, FORMATTING B
This will clear formatting on the text, removing 'Zi?sﬂiz?t?ggtéwﬂz ::ggreet Nomal - ||@ame - '
the white boxes. dolore magna aliquam erat/ : opx ¢ O £

> The resulting text may not retain its settings, ' (e S
requiring resetting the font attributes. eslioox 4] Ellam

WHITE BOXES BEHIND CLEAR THE
PASTED TEXT TEXT FORMATTING

(8" PURDUE
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......... [ Overview ]

Images

My Images is your individual image gallery, which
can be accessed in the Left Content Pane.

> Upload, drag and drop, and insert images.

> Upload PDF files and single PDF pages.

> Replace and delete images.

> Access GoogleDrive collections and galleries.

*see page 15 for Google Drive integration

Image file formats

¥e)

Shapes

oo
o%
QR Codes

5
My Images

> Marqg accepts the following image file formats:
JPG, PNG, SVG. EPS files are not supported.

PURDUE
(& GLOBAL

(S

Tables

=

Data

‘D

smart Fields

PURDUE &

GLOBAL

Y
y

PURDUE
GLOBAL

Manage Images
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......... [ Overview ] Create a document ............{DownlgadyQurfile).............[ Marqfeatures }

Add Google Drive to Marq

Add images or sync GoogleDocs copy to your Marq

tempates by integrating Google Drive to your Marq
user account.

INTEGRATIONS

> You must be logged into Marq and Google Drive and use — N — —
the same email for both accounts. = shle L o
> Click on your name in the bottom left corner, then R U ——
“Account Settings” | Ee
> In the left menu bar, click on “Integrations.” | e g e
> Under the Google Drive heading, click “Link to Drive” emm—————— LINKTO DRIVE
> Follow the prompts and make selections on the access o —— .
you would like Google Drive to have. S
> Go to Image Manager, click “Add Integrations,” hover

over the Google Drive logo and click “enable.”

Svnc Google Drive to Marg article

(8 PURDUE
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https://help.marq.com/sync-lucidpress-to-google-drive

......... [ Overview ] Create a document ............{Downloadygurfile].............[ Marqfeatures }

Upload images

@ Upload Image
H My Brand
> Upload animage to My Imaggs, or . S—— ol A
drag and drop a JPG or PNG image
from your desktop into your document, -
[ RGB Pla.. (] CMYKPL.

> You can also upload folders of images
and PDFs. PDFs will convert to 55335
individual PNG images when uploaded.

0g
D=+

R 8 (8 PURDUE
M) & GLOBAL

|
My Images \‘

PURDUE
B "GLOBAL
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Overview Create a document

Insert images

> Open your My Images window.  foweon

> With an image box selected in mD r’ :;‘:.
your document, click on an ‘
- . . Upload Image
image to insert in the box. —
. Search Images (o -
> Or drag and drop an image o
from your device into your T =
document.
CLICK TO INSERT
PURDUE
(6 PURDUE
Q' GLOBAL

Download your file

FIRSTNAM

One or more |
go here

Lignimporro exer,

nonem nonet volg
qui doloreptatis rf
prehendaerem ut
dolo magnatam e

ariscit, et dia olor]

qui doloreptatis.

Marq features

DRAG AND DROP

MARQ USER GUIDE

17



......... [ Overview }

Crop and mask images

> Select an image in your document.

—r
> In the Image panel at right, click on the NP— = D e
. . 11276 In 3| @ 7.33330n3
Image drop-down section. Then click the . . i)
- . . ‘Customm.. v | '|‘I_| '
Crop & Mask icon in that section. MAGESCALE | crom & wask
> The image will be highlighted, - K
. HORIZONTAL ALIGNMENT EFFECTS
allowing you to move the borders of the |
cropping box to crop the photo, or to VERTIBAL AUGNNENT
drag the photo to scale or reposition.
> Hit return/enter on your keyboard to

CROP & MASK
exit the cropping view.

CROP, SCALE OR REPOSITION

PURDUE
W  GLOBAL.

MARQ USER GUIDE | 18



......... [ Overview ] Create a document ............{DownlgadyQurfile}............[ Marq features }

Replace images

> Double-click on an image in your Browse rives
document to open My Images. m P | =
images PhotoShelter With Me
H . : ', Replace lmage | T *
> Select a different image and click i el
Upload Image
Insert, or use the image editor to
. Search Images Q %=
replace the current image.
My Images
[ RGB Pla.. [ cMYKPL..

CLICKTO
REPLACE IMAGE

“3-LINE QUOTE.

PURDUE o8
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......... [ Overview ] Create a document ............{Downlgadygurfi|e].............

| My Brand
Delete Images A
g My Images -
Text
i [ RGB Pla... [ CMYKPL.
> To delete an image from My Images, 2 : |
open My Images. At the bottom of that Stapes R
window, select Manage Images. | n
: Be | ¥ = Qe IR
> The Image Manager will open. Hover ar codes L 0% . oiRpuE | PURDL o LOE
over a photo and three vertical dots - 4 GLOBAL GLOBA <.
. . F??—Lg(go—v—mll-RGB Select All “Fuli-R
appear in the lower right corner. D {‘ R, CLICK 3 DOTS
. My Images ON PHOTO,
> Click on the dots, scroll down to Trash and PU\I?DUE s D SELECT TRASH
click to move the image to Trash. B GLOBAL _ |
ables ge Manager x
> In the Image Manager, select the Trash o :
icon and click Empty at the upper right = cownae: [ .,wwwmwwi
to delete the photo. P o
* Lo m EMPTY TRASH
Smu:'tEF:atds : ; ::;Mmel 2025_PO_KAL_2525pg
» 7 Purdue Global )
» [ sociol media
» 3 virtuol blgd i
SELECT MANAGE kil = kgd
IMAGES = e

(8" PURDUE
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......... [ Overview }............[Createadocument}............. Downloadyourfile [ Marq features }

|
Download for print | cwxcooriom:
METHOD 1: ORDER PRINTS > SELECT STANDARD SIZE > CHECK MY DOCUMENT > CHECK SAFE AREA > DOWNLOAD AND REVIEW PDF

: Product & Size _I
& & S —  Check My Document Remove Any White Edges & — Reviaw o POF Proof of Your Design
T 2-Sided Bullet List Flyer B.5xMin Check the Safe Area Once downloaded, open the PDF and carefully check your proof.
i Print HAME OF PROJECT Sz To ensure the quality of your print —_——
order, we recommend you run our Rttt bl b o S Sapnisdhess
E print check. This includes checking for Bleed Line:
= = = i i, t i hi
@ @ = = high-resolution images, bleed, correct In order to uvcn% any white edges, Cancel Add to Cart
——— colors, and more. extend your design to the black edge
— T of the entire document.
Order Prints  Print Locally * in ¥ e Why is this important?
PRCESIZE uNITS 0.125in §
8.5xM asxn ® Check My Document o
Ik][=} M Gatefold Notepad - 2 (Recommended)
ORIENTATIO. SPREADS BACKGROU- Brochure sides Don't Use Smart Print Checks Safe Areq: -------
85x1in 85xin Make sure important text or images
PO i R @ . are inside the dotted line to avoid
HEAD SOFIA PRO COND BLACK 16 PT Cover page with spreads Check Docu.. being cut off when printed
d Sofia Pro Condensed Bold 18 pt > Headers & Footers T ] [ ] Why is this important?
ular 9 point. Approodmately 378 words. E Lorem ipsum dolor sit amet, consecteter adipiscing et — | — S —
lor 541 ame, consectetuer adipiscing elit, sed dism nonumemy nibh euismod tincsdunt ut laceest -— D —
mamy nibh euismiod tincidunt vt lacreet dolore magra aliquam erat volutpat. Ut wisi enim ad minim » Mﬂrﬂll’l! =
liquam erat volutpat. Ut wisi enim ad veninm, quis nostrud exerci tation ullsmeorper suscipil
ks nostrud exarci tabian llameorper Iobortis nis| ut aliquip ex ea commodo cansequat. Duis Landscape Landscape
nisd ut abquip ex #a commodo consequat. autem vel sum iriure dolor in hendrerit in vulputate velit
i ek oloe i hemdewet 1 lutale W RIS SN vl Wi bRy 7 » Project Lock ) Mega Mega _ 7
tie consequat, vel llum dolore eu feuglat Facilisis at vera ros e accumsan ef lusto odio dignissim qui Postcard - Post d- Back Review POF Pr.
vera ercs et accumsan of iusto odia blandit praesent luptatum zzril delenit augue duis dolore to
landit praesent luptatum zeril delenit feugait nulla. » Prn]octA l Mﬂi“ﬂg Shlp Only
i bo Teugait nulle, phravs 85x1in 85x1lin
Lorem ipsum dolor sit amat, consectetuer adplscing elit
dor 5it amet, consectotuer adipiscing oit, sod diam nonummy nibh euismod tincidunt ut laoreet
rumy nibh euismod tincidunt ut lacreet dolore magna aliquam erat volutpat. Lorem ipsum dolor sit
liquam erat volutpat. Lorem ipsum dolor amet, consectetuer adipiscing efit, sed diam nonummy nibh
ftetiser adipiscing efit, sed diam nonummy ewismod tincidunt ut koreet dolore magna.
hciunt oot solocs e ko | ]
Two-Sided Two-Sided
Landscape Portrait
PURDUE . -
GLOB L NxBS5in BS5xNin




Overview

------------[Createadocument]------------- Download your file [ Marq features

CMYK color format

Download for print

METHOD 2: PRINT LOCALLY

> DOWNLOAD PRINT-READY PDF

= =

Alltools

Y - |

=

Efit  Comvert E-Sign )"

PDF

PG 2-Sided Story Flyer-2.pdf

1.9 MB @ S

TITLE HERE

-2 LINES

Order Prints  Print Locally ¥ £,
-2 LI N Es CD]D . TITLE SUBHEAD SOFIA PRO CONDENSED BLACK 16 PT
S sacKeRoUND Story Head Sofia Pro Condensed Bold 18 pt
Acumin Pro Regular 8 paint. Approximately 375 words. Lorern dalor sit amet, dipiscing elit,
Lorem ipsurn dolar sit amet, consactetuer adiplscing e, sed diam noaummy nibh ewsmod tinciduat ut laoreet
» Margins 3 sad diam nonummy nith sulsmod tincidunt ut laceest

B

¥miutpat. Lover ipsum t

e diam nonumimy nibh

» Page Lock

dalore magna aliguam erat volutpat, Ut wisi enim ad
minim veniaem, qués nostrud exerc tation ullameorper
suscipit kabertis nisd ut aliquip #x ea commeodo consequat
Duit autem vel eurn iriune dolor in hendrert in vidputate
welit lestie consequat, vel illum dob fougist
nulla tacilisis at vers eros ot accumsan ot kusto odia
dignissim qui blandit praesent kiptatum zzil delenis
augue duks dolore te feugait nulla,

Lorem ipsurn dolor sit amet, consectetuer adipiscing elit
sod dism nanummy Ribh euismod tineidunt ut laoneet
dolere magna aliquam erat volutpat, Lorem ipsum dalor
=it mmat. consectetuer adipiscing o8, sed diam nonumimy
nibh euismed tincidunt ut lagreet dolore magna aliquam
erat volutpat, Duss auter ved eum iure dolor in hendrerit
in vulputate velit esse molestie consequat, vel illum dolore
eu fougiat nuila faciliszs a1 vera eros of accumsan et iusto
odio dignassim qui blandit prassent luptatum zzril delenit
augue duss dolore e feugan nulls facisl,

dolore magna aliquam erat volutpat. Ut wisi anim ad minim
vanlam, quis nostrud exerci tation ullamcorper suscipit
Iobartis nisl ut aliquip ax ea commoda consequat. Duis
aubem vel eum iriune dolor in hendrert in vulputate velit
esse molestie consequat, vel llum dolare eu feugiat nulla
facilisia at vera efos et accumasn et iusto odio dignissim qui
blandit pragasnt lugtaturn 2208 delenit sugue duls dolore te
feugalt rulla.

Loremn ipsum dolor sit amet, consectetuer adipiscing elit,
sed diam nonummy nibh esismod tincidunt ut laoreet
dolore magna aliquam eral volutpat. Locem ipsum dolor st
amet, consecietuer adipiscing ofit, sed diam nonummy nibh
euismad tincidunt ut oreet dalore magna.

Bﬁ"?@g

B a ¢

2
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--------- [ Overview }------------[Createadocumentj------------- Download your file [ Marq features }

Download for digitaI/SOCiaI RGB color format

& [ © Print LTy share ] & Perint LT} share
I Share your design I <
rehfo y ! Q cial 1
— &3 postiosoctd > Post to social:
Lect Series Titl E
ecture Series Title . - - - - X (£] in] e X, FB, |_|, Buﬁer,
b R = e X Facebook Linkedin Buffer IG Business
ECTURE TITLE ik
p’acehOIder <@ Post to social > ":’"“9"“':‘ "':“’Ig"’m
Go Es H ERE box to ¢S Publish on the web > T > Publish b
e . . ublisn on we
" Event date ﬂ Inser t 'mage . bownioad ’ & & & . . .
—._- @ Print ) Publishon Embedinan Embedona > E m bed I n e m a I I/We bS Ite
Localmn- O Jrivits Colliborators > the Web Email Website
Other details Images
=+ AllOptions > > Images — download
I b= ] (2] & .
» Project Approval options: PDF, PNG,
""""""""""""""""""""""""""""""""""""""""""""""""" E— " Transparent PNG, JPG

(8" PURDUE
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......... [ Overview ].............[Createadocument]............{DownlgadyQurfile]............. Marqfeatures

Spell check

> Marqg's Spell Check feature is indicated Co-Brand Presentation
by words underlined in red. [Fi] vt Jovos e

a o

] } + New Page
> This can be turned on or off in the
. . . Select >
File menu in the top navigation.
Duplicate

Convert to Template

Download As

Paragraph highlight 75 words. Minimum 16
point type for presentation legibility. Lorem

Print *® P ipsum dolor sit amet, consectetuer elit, sed
Order Prints diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat.
v Spell Check > o : :
- Paragraph highlight lorem ipsum dolor sit
Fined ix Repidce amet, consectetuer adipiscing elit, sed diam

nonummy nibh euismod tincidunt ut laoreet
dolore magna aliquam erat.

(© Revision History...

Get Change Notifications
Paragraph highlight lorem ipsum dolor sit

amet, consectetuer adipiscing elit, sed diam
Accessibility Settings nonummy nibh euismod tincidunt ut laoreet
dolore magna aliquam erat volutpat.

Preview

(8" PURDUE
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Overview ] ------------- [Create a document]

Locks

> Locking properties of page elements is a tool

within Marq that Purdue Global uses to manage
the integrity of the brand.

A red lock locks all properties. If an object is fully
locked, it will have a red lock and border.

A yellow lock is a partially locked object. It will
have a yellow lock and border. Users can utilize and
modify the unlocked properties.

You can add locks to your projects as well. If a
user shares their document, their locks will be in
place for the next person, but the second user will

be able to unlock elements locked by the first user.

PURDUE

Q' GLOBAL

00.00.00

EVENT TITLE

Location

Details

MARQ USER GUIDE
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......... [ Overview ].............[Createadocument]............{DownlgadyQurfile]............. Marqfeatures

Notes

> To make the brand templates easier to use,
notes have been added with font and color
specifications or helpful tips. Click on a note
icon to read it.

NOTE ICON

CLICKTO SHOW INFO

Sofia Pro Condensed Bold
159 pt, all caps
Headline color: White RGB

> You can also add notes to unlocked page
elements. Go to the Insert menu and select
Note, or right-click on an object in Marq to add

a note. 00.00.00

EVENT TITLE

Location

Details

(8" PURDUE
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--------- [ Overview ] Ceereneaian [Create a document]

Off-page content

> Off-page content such as information, extra
text and images can be placed in the gray area
outside the edges of your document.

> For example, the retractable banner templates
contain details on the pasteboard about visible
areas for art and printing specifications.

> To turn off-page content on or off, go to
View > Show Off-page Content.

> You can also delete your unused elements
from the pasteboard to keep it clean.

PURDUE
(& GLOBAL

OFF-PAGE
CONTENT

Extra social icons
can be deleted.

Bottom 2 inches of
artwork will be hidden
in banner hardware

(»
VL

PURDUE
GLOBAL.

LEARN MORE
purdueglobal.edu

FOLLOW US
@unit-handle
FEman
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